
172 
 

HFSS-13   часть 3 
 
 

14. Анализ рупорной антенны во 
временной области 

 
 
 

 
В этом примере мы будем использовать метод расчета переходного 

процесса, чтобы получить S-параметры рупорной антенны в  широкой 
полосе частот. Широкополосная антенна может использоваться для передачи 
коротких импульсов, например как часть радиолокационной системы 
подповерхностной локации земли.   

Мы будем использовать имеющуюся в библиотеке примеров модель, 
содержащую антенную геометрию, создадим остальную часть модели и 
выберем метод расчета переходного процесса.       

В этом разделе рассматриваются подготовка модели и анализ 
переходного процесса в рупорной антенне во временной области. 
 
     Запуск  HFSS и открытие модели. 

 
1. Запустите HFSS 13. 
 
2. Командой File>Open загрузите файл broadbandhorn.hfss  из папки Help  в 
директории инсталляции HFSS 13. Это размещение отличается от 
расположения в папке example. Вы будете добавлять границы, возбуждение 
и задавать поверхности, на которые будут выводиться поля. 
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Рис. 14.1. Вид рупорной антенны 

 

      
 

Рис. 14.2. Размеры рупорной антенны и конструкция порта 
 
3.  Задайте  команду меню HFSS>Solution Type, чтобы выбрать тип решения 
Transient Network Analysis (рис. 14.3). 

 
Рис. 14.3. Диалог выбора типа решения 
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5. Задайте свойства материала рупора как медь и объекты pin. Геометрия 
включает также воздушный бокс, стороны которого покрыты слоями PML. 
 
6. Создайте воздушный бокс с начальной вершиной (X,Y,Z)=(-100, -250, -
180) и размером (dX, dY, dZ)=(550, 500, 360). Свойства этого бокса показаны 
в диалоге, показанном на рис. 14.4. 
 

 
Рис. 14.4. Параметры базового бокса рупорной антенны 

 
     Фаски этого бокса расположены на расстоянии, большем, чем 100 мм, от 
рупора. Так как мы собираемся использовать PML, и минимальная частота 
будет 0.7 GHZ, это даже больше, чем нужно. 
    Заполним воздухом этот бокс, дадим ему название, цвет и проницаемость. 
На сторонах этого бокса зададим  граничные условия PML. 
 
7. Выделите все фаски воздушного бокса. 
 
8. Выберите Boundaries>PML Setup Wizard. Появляется мастер создания 
идеально поглощающих плоскостей (рис. 14.5). Мастер сам корректирует 
материальные параметры, чтобы получить хорошее поглощение в слое с 
заданной толщиной. 
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Рис.  14.5.  Создание идеально согласованной слоя с толщиной Thickness = 

100 mm  в ассистенте PML 
 
9. Кликните Next. 
 
10. Задайте минимальную частоту и минимальную дистанцию до плоскости 
излучения Minimum Radiating Distance, как показано на рис. 16.6: 0.7 GHz 
and 100 mm. 
     Эти установки нужны, чтобы HFSS сгенерировал правильные параметры 
слоя PML. 

 
 
Рис. 14.6. Установка частоты и дистанции в ассистенте PML 
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11. Кликните Next и затем Finish. 
 
 
Задание плоскостей для вывода динамически изменяемых 
полей.    Нужно решить заранее, где мы хотим видеть поля в полной 
трехмерной модели на каждом шаге изменения времени. Создадим два 
перпендикулярно развернутых прямоугольника, на которых мы хотим 
сохранить поля (рис. 16.7,16.8). 
 
1. Создайте прямоугольник в плоскости XY  с точки (X,Y,Z)=(-100, -250, 0) 

с размером (Xsize, Ysize)=(550, 500). 
 

Рис. 14.7. Горизонтальная плоскость, 
пересекающая рупорную антенну 

Рис. 14.8. Плоскость, на котором 
выводится поле 

 
 
2. Создайте прямоугольник в плоскости XZ с точкой  (X,Y,Z)=(-100, 0, -180) 
и размером  (Xsize, Zsize)=(550, 360). 
 
3. Выведите эти прямоугольники в виде рамок. Теперь нужно определить 
этот список как  “list” для того, чтобы позже сохранять поля на них. 
 
4. Выберите оба прямоугольника. 
 
5. Задайте команду  Modeler>List>Create>Object List (или нажмите Face 
List если вы выбрали их в режиме выбора фасок). 
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Рис. 14.9. Выбор имени “Objectlist1” на “PlotFields” в окне свойств 
Properties 

 
6. Задайте этому списку имя, например “PlotFields”, как показано ниже, через 
дерево модели и окно свойств. 
 
7. Сохраните модель командой Save. 
 
 

Источники возбуждения.     Плоскость “source” будет волновым 
портом. 
 
1. Кликните  Tools>Options>HFSS Options, чтобы вывести диалог HFSS 
Options.   В закладке General, в разделе Assignment Options, проверьте, что   
опция Auto-assign terminals on ports не отмечена и кликните OK. 
 

 
 

Рис. 14.10.  Закладка General диалога HFSS Options 
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2. В дереве проекта выберите плоскость с именем  “source”. 
 
3 View>Fit Selection. Заметим, что этот объект является сечением 
коаксиального кабеля, внешний проводник которого outer есть часть круга. 
 
4. Задайте Wave Port для этой плоскости. 
 

 
Рис. 14.11. Выбор объекта для опорной (земляной) плоскости 

 
5. Дайте порту имя  p1 и кликните Next. 
 
6. Задайте порту опцию Active. Кликните Next. 
 

 
 

Рис. 14.12. Задание волнового порта активным 
 
7. Выберите опцию “Do Not Renormalize” (рис. 14.13).  Импеданс порта 
ожидается равным  точно 50 Ом, и рассматривается как действительный 
импеданс, который будет корректно согласован с импедансом модели.  
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Рис.  14.13. Последний шаг в установке волноводного порта 
 
8. Кликните Finish. 
 
 
    В проекте с методом Transient Network Analysis с несколькими портами, 
чтобы получить полную S-матрицу необходимо подавать сигнал на один из 
портов. Такой порт назовем активным. Каждое моделирование с одним 
активным портом дает один столбец S-матрицы. Когда вы определяете порт 
как пассивный, это означает, что сигнал на него не подается, а он нагружен 
на согласованную нагрузку. 

В проекте с расчетом переходного режима (не network analysis), все 
активные порты будут одновременно включены (ON), в то время как 
остающиеся пассивные порты будут действовать только как оконечные 
нагрузки (OFF). 
 
 

   Спецификация терминала.    Поскольку программа HFSS 
Transient использует порты Terminal-Driven, нам нужно задать сопротивле-
ния портов. 
 
1. Кликните правой кнопкой мыши p1 в дереве проекта и выберите Auto 

Assign Terminals. 
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Рис. 14.14. Выбор опции 
автоматического определения 
терминала  

Рис. 14.15. Спецификация проводников, 
касающихся порта, которые будут 

противовесом 
 

 
Рис. 14.16. Компоненты волнового порта 

 
 
2. Выберите  horn как  опорную плоскость Reference, так что pin будет 
терминалом. 
 
 

Расчет и вывод результатов.   Этот раздел описывает установки 
на решение временного процесса и просмотр результатов. 
 
1. В дереве проекта, выберите  Analysis>Add Solution Setup. 
 
2. Сетка для переходного моделирования создается на основании  
моделирования в частотной области. В этом моделировании программа 
останавливается на соответствующей частоте,  чтобы выполнять адаптивный 
расчет. В этом случае использовать смешанные порядки элементов и 
итеративное решающее устройство. Примите значения по умолчанию в 
закладке General (рис. 14.17). 
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Рис. 14.17. Установки в закладке General 

 
3. В закладке Input Signal (рис. 14.18), задайте полосу частот от 700 МГц до 
1.6 ГГц. Это полоса соответствует модулированному импульсу Гаусса во 
временной области, который можно видеть в панели. 
 

 
Рис. 14.18.  Временной процесс на входном порту 

 
 
4. В закладке Duration, вы должны задать границы по времени при анализе 
переходного процесса. Для этого примера, выберите Auto Terminate. 
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Рис. 14.19. Здание точности расчета временного процесса 

      
Параметр Target Residual (Разница до сходимости)  характеризует 

минимальное поле в модели в данное время по отношению к его самому 
большому значению. Как только поля падают ниже 0.001 от самого высокого 
значения, моделирование может быть остановлено. Дополнительно, Вы 
можете определить максимальный (At most) и минимальный (At least) 
интервалы времени, в которые нужно моделировать переходной процесс. 
Встроенные максимальные и минимальные интервалы времени подходят в 
большинстве случаев. Они учитывают размер модели и тип сигнала.  
 
5. В закладке Saved Fields (рис. 14.20), отметьте опцию Object List or Face. 
 

     Установите интервал, через который будут запоминаться значения 
поля равным 30 ps. Это - "достаточно малая" часть длительности 
широкополосного импульса, чтобы получить в дальнейшем плавную 
анимацию поля. 
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Рис.  14.20. Опции сохранения поля в закладке Save Fields 
 
6. В разделе  Radiated Fields  установите опции сохранения полей и во 
временной и в частотной областях на частоте 1.2 GHz, как показано на рис. 
14.21. 
 

 
 

Рис. 14.21. Выбор частоты, на которой сохраняется излучающее поле 
 
7.  Шаг установки на решение Solution Setup выполнен. Кликните OK. 
 
 
    Моделирование. 

 
1. Запустите моделирование. 
 

Вся область прогресса решения (см. рис. 14.22) соответствует 
максимальному времени моделирования в закладке Duration диалога 
Solution Setup, или, если оно не определено, то величине   20*(диагональ 
модели) / (скорость света). 
    Область красной стрелки показывает время моделирования  относительно 
максимального времени, в течение которого моделирование будет 
выполнено. 
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Рис.  14.22. Наблюдение процесса расчета, показывающее время 
моделирования по отношению к общему времени расчета 

 
     Во время моделирования, вы можете видеть прогресс расчета и другим 
способом. 
 
2. Нажмите правой кнопкой на Results в дереве проекта и выберите Create 
Terminal Solution Data Report>Rectangular Plot. 
 

 
 

Рис. 14.23. Выбор характеристики во временной области 
 
     Выведите  Input и Output на одном графике и Residual в dB20 на другом. 
     



  185

 
 
Рис 14.24. Напряжения  Input и Output (возбуждение и отражение) как 
временные функции  
 
 
   Input и Output показывают возбуждение и отражение на порту как 
функцию времени. 
 
      Характеристика Residual ( рис.14.25) показывает меру для уровня макси-
мального поля в модели. Моделирование завершается, когда Residual спада-
ет ниже  0.001 относительно его пика в любое время. 
 

 
Рис.  14.25. Параметр Residual в логарифмическом масштабе, как функция 
времени  
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   Визуализация характеристик структуры.  
 
1. Чтобы вывести характеристики   S-параметров как функции частоты, 
снова нажмите правой кнопкой на Results в дереве проекта и выберите 
Create Terminal Solution Data Report>Rectangular Plot. 
 
2. Измените выбор в окне Solution на Spectral как показано на рис. 14.26. 
 

 
 
Рис. 14.26. Подготовка к выводу S-параметров parameters как функцию 
частоты, т.е. в виде спектра временного процесса 
 
3. Нанесите модуль |S11|. Результирующий график показан на рис. 14.27. 
Этот график изменяется, когда расчет еще продолжается. Это позволяет вам 
видеть этот график на ранних шагах расчета. 
 

 
 
 
Рис. 14.27. Частотная характеристика |S11| для широкополосной рупорной 
антенны 
 
 
Бегущее поле рупорной антенны. 
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   Чтобы создать бегущее поле, выберите список, названный “plotfields”  в 
дереве модели, т.е. список, содержащий два прямоугольника которые вы 
создали для вывода поля.  
      В дереве проекта, кликните правой кнопкой Field Overlays>Plot 
Fields>E_t>Mag_E_t и выберите произвольное ненулевое время на 
следующей панели (рис. 14.28). Вы можете всегда подстроить время, 
изменяя его выбором  Modify. 
 

 
 
Рис. 14.28. Создание бегущего поля в заданный момент времени t= 3.044 пс 

 
    Теперь имеется возможность наблюдать бегущее поле. Причем в отличие 
от метода FEM, здесь мы видим поле, изменяющееся во времени в 
соответствии с временным процессом входного сигнала (рис. 14.29). 
 

 
Рис. 14.29.  Распространение поля в двух перпендикулярных плоскостях 
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3. Измените масштаб напряженности поля, чтобы сделать видимым поле в 
диапазоне от 0 до 10 V/m. 
 
4. Анимация графика волны распространения можно выполнить, нажимая 
правой кнопкой мыши на имя графика и выбирая Animate. В окне Setup 
Animation, вы можете выбрать число шагов. Если нужно, HFSS выполнит 
интерполяцию между сохраненными решениями поля. 
 

 
 

Рис.  14.30. Окно установки анимации поля 
  
   Визуализация поля излучения. 
 
     Чтобы рассчитать поля во временной области:  
1. Кликните правой кнопкой на Radiation и выберите  Insert Far Field 
Setup>Infinite Sphere. 
 

 
Рис.  14.31. Выполнение установок дальнего поля 

 
2.  В дереве проекта кликните правой кнопкой на Radiation и выберите Insert 
Far-Field Setup>Infinite Sphere. Задайте диапазон углов, как показано на 
рис. 14.32. Это диапазон в плоскости  XZ,  и диапазон от зенита до горизонта 
в направлении  прямого излучения  антенны. 
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Рис.   14.32. Задание только одной точки на сфере дальнего поля 

 
3. Теперь в дереве проекта, кликните правой кнопкой мыши на 
Results>Create Far- Fields Report>Rectangular Plot. 
 
4. Выберите характеристику rEz как функцию времени. 
 

 
Рис. 14.33. Вывод характеристики напряженности поля в дальней зоне 
 
5 . В закладке Families, задайте  Theta = 90° и Phi = 0°. 
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Рис. 14.34. Закладка семейств вывода характеристик 

 
    Пояснение:   Компонента Ez является доминирующей. Поэтому она 
выбрана на рис. 14.33. Произведение  r  на Ez  полезно, потому что оно не 
зависит от расстояния от источника до точки наблюдения в дальней зоне. 
Параметр rE имеет размерность  [В], так как поле E имеет размерность  
[V/м], а расстояние r [м].  

На рис. 14.35 показывается форма временной зависимости поля в 
дальней зоне. Этот график показывает, как искажается сигнал, излучаемый 
антенной. Эта информация может использоваться, чтобы улучшить 
конструкцию антенны, например,  разумно помещая резистивные ленты в 
некоторых ее точках. Это - также полезная информация на этапе  
постпроцессорной обработке данных расчета. 
 

 
Рис.  14.35. Изменение дальнего поля излучения, co-polarized, в центре 

главного луча. 
 
   Если нужно, вы можете также создать частотно-зависимое дальнее поле  
при изменении решения к Spectral  и изменения угла Theta как первичного 
параметра, как показано в диалоге рис. 14.36. 
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Рис. 14.36. Вывод характеристики дальнего поля в спектральной области 

 
    В закладке Families (рис. 14.36) можно видеть, что ранее установлена 
частота 1.2 GHz, в закладке Radiated-Fields установки решение Solution 
Setup, и таким образом, можно выбрать опцию Spectral. 
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15. Проектирование наноразмерных светодиодиодных    
модулей 

 Одной из актуальных задач,  возникающих на стыке между оптическим 
и СВЧ – диапазонами, является обеспечение эффективного излучения 
световых электромагнитных волн в средах со сложной частотной 
зависимостью их свойств. К таким средам, в которых анализ 
распространения электромагнитных волн представляет довольно сложную 
задачу, можно отнести безэлектродные разряды в плазме, метаматериалы с 
отрицательной диэлектрической и магнитной проницаемостью, а также 
полупроводниковые гетероструктуры. В данном разделе рассматриваются 
возможности повышения эффективности светодиодных модулей на основе 
резонаторных систем с  квантовыми источниками электромагнитного 
излучения[8]. 
     Развитие техники СВЧ по мере увеличения частоты всегда сдерживалось 
технологическими возможностями. Поэтому, например, в субмиллимет-
ровом диапазоне длин волн невозможно было использовать столь же 
эффективные резонаторные и замедляющие системы, как в сантиметровом 
диапазоне. 
   Однако в настоящее время в связи с успехами в развитии нанотехнологии 
такие возможности появились, и теперь можно использовать богатый опыт 
разработок СВЧ систем в приборах оптического диапазона, включая лазеры и 
светодиоды. Кроме того, результаты моделирования потоков электронов и 
фотонов позволяют в едином процессе моделировать активные и пассивные 
элементы. При этом в качестве источников электромагнитного излучения 
можно задавать точечные источники в виде коротких отрезков тока. 

  Разработчики HFSS  предусмотрели такие возможности. В библиотеку 
материалов можно включать наноразмерные изотропные и анизотропные 
материалы. Однако требуется убедиться в достоверности  работы программ 
при расчете структур с предельно малыми размерами, на которые воздейст-
вуют  электромагнитные волны светового и СВЧ диапазонов волн. Особенно 
важным является то, что необходимо правильно описать источники световых 
волн. В программах электромагнитного моделирования в качестве источни-
ков излучения можно использовать источники тока или напряжения с собст-
венными размерами, намного меньше длины волны. 

    Рассмотрим светодиоды (СД) с объёмными резонаторами (ОР), которые 
считаются перспективными  [8], поскольку имеют существенные преимуще-
ства в сравнении с обычными СД. Например,  интенсивность спонтанного 
излучения светодиода при использовании высокодобротного резонатора уве-
личивается на порядок за счёт сужения спектра люминесценции. Кроме того,  

улучшается спектральная чистота и повышается направленность, а также 
температурная стабильность излучения, как отмечено в  [8]. 
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15.1. Моделирование  структуры  и  источников 
возбуждения в оптическом диапазоне волн 

   Принцип действия светодиодов основан на использовании полупро-
водниковых гетероструктур, которые состоят  из слоев с n- и p-проводимо-
стью. Благодаря разной концентрации носителей зарядов в отдельных слоях 
и наличию в этой сложной структуре областей, в которых происходит интен-
сивное накопление зарядов, возникают условия для перехода носителей заря-
дов с одного энергетического уровня на другой, и имеют место излучения 
фотонов, обеспечивающее свечение в определённом диапазоне длин волн. 
Эти участки концентрации носителей зарядов называют квантовыми ямами, 
нитями и точками в зависимости от того, как в них локализованы фотоны [9-
11]. Простые модели этих квантовых участков в соответствии с [10] пока-
заны на рис.15.1. 

 

 
 

                    а)                        б)                        в) 

Рис.15. 1. Активные области гетероструктур, в которых источники 
света представляются в виде квантовых ям (а), нитей (б) и точек (в) 

 
В [8] приводятся фотографии и структуры реальных СД с ОР, которые 

используются в волоконно-оптических системах связи инфракрасного диа-
пазона длин волн. В качестве наиболее коротковолнового СД, излучающего 
на длине волны 650 нм, представлена структура, изображённая здесь на 
рис.15.2,а.  

        
 
                            

                       а)                                                                      б) 
Рис.15.2. Структура (а) и спектры (б) СД на основе GaInP/AlInGaP с 

МКЯ и зеркалами Брэгга из слоёв AlAs/AlGaAs. 
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Резонатор образован многослойными зеркалами Брэгга. Активная об-
ласть СД содержит множество квантовых ям (МКЯ). Спектры излучения 
этого СД показаны на рис.15.2,б, где для сравнения по интенсивности и ши-
рине приведены также спектры обычного СД при разных токах. 

 
Из рис.15.2,б следует, что введение ОР обеспечивает увеличение ин-

тенсивности свечения в заданном направлении. Светотехники при этом гово-
рят о возможности получения высококонцентрированной кривой силы света, 
а в терминологии электродинамики в данном случае используется понятие 
узкой диаграммы направленности. 

При проектировании СД с ОР в [8] рекомендуется выбирать резона-
торы с наименьшей длиной, возбуждаемые на фундаментальном виде коле-
баний (ВК), и имеющие наиболее высокую собственную добротность, т.е. 
наименьшее поглощение (потери) в резонаторе. Однако реальные СД с ОР, 
включающие распределённые зеркала Брэгга и работающие на ВК, не вполне 
удовлетворяют этим рекомендациям. 

 
    Для решения задач оптического диапазона используя программы 
электродинамического моделирования, моделирование дискретных и 
точечных источников световых волн, а также распределенных источников, 
можно выполнить, можно использовать отрезки токов вдоль линий передач. 
Поглощение и потери в металле можно моделировать так, как это делается в 
диапазоне СВЧ,  т.е. в виде скин-эффекта,  модели металла с отрицательной 
диэлектрической проницаемостью, с помощью поверхностного импеданса 
(сопротивление на квадрат поперечного размера).  Итак, после формализации 
задачи и решении вопроса о моделировании структуры, можно рассмотреть 
задачу проектирования и оптимизации пассивных структур светодиодных 
модулей. 
 
 

15.2. Падение плоской волны на частотно-селективную 
поверхность 
 

   Важной  практической  задачей  в  световом  диапазоне,  можно  считать 
расчет падения световой волны на поверхность со сложной структурой. 
Поверхность с произвольной структурой можно отнести к частному слу‐
чаю частотно‐селективной поверхности. Поэтому, поставим задачу рас‐
считать  электродинамические  характеристики  этой  поверхности  для 
различных форм, материалов и потерь, свойственных этой поверхности.  

    Если считать, что спектр световой волны, излучаемой гетерострукту‐
рой, имеет вид, показанный на рис. 15.2,б, то зная коэффициент отраже‐
ния  частотно–селективной  поверхности, можно  получить  спектр  отра‐
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женной  волны.  Для  того  чтобы  решить  задачу  падения 
электромагнитной  волны  на  поверхность,  нужно  смоделировать 
структуру  бесконечного  размера  и  применить  периодические 
граничные  условия,  которые  реализованы  в  программах  HFSS.  
Использование  периодических  граничных  условий  резко  уменьшает 
объем задачи и позволяет на  современном компьютере  с  оперативной 
памятью 4 ГБ решить задачу с нужной точностью.  

Рассмотрим  бесконечную  многоштыревую  структуру,  состоящую  из 
цилиндрических  стержней,  показанных  на  рис.  15.3,а  графическими 
средствами  HFSS  .  Для  моделирования  бесконечной  структуры  нужно 
использовать  специальные  граничные  условия,  так  называемые, 
связанные  периодические  граничные  условия.    Расчеты  показали,  что 
волна, падающая на штыри (рис. 15.4), возбуждает синфазные поля ме‐
жду штырями.  

    Программа HFSS позволяет решить задачу падения электромагнитной 
волны  на  бесконечную  структуру  с  произвольной  формой  и  с  учётом  
потерь. Сверху и снизу структуры, охваченной периодическими гранич‐
ными  условиями,  выберем  точки,  в  которых  рассчитывается  ближнее 
поле перед плоскостью, и за плоскостью (т.е. отраженная и проходящая 
волна).     Представляет интерес определение частотных характеристик  
селективной  поверхности  при  различных  структурах,  отличающихся 
также  шероховатостью  поверхности  штырей,  материалом,  формами, 
размерами  структуры,  её  периодическим  или  случайным  характером 
повторения.     Частотную характеристику можно определить, выполняя 
моделирование  падения  плоской  волны  на  поверхность,  а  также 
возбуждая структуру с помощью точечных источников света. 

Один из вариантов устройств с четвертьволновыми  ОР и КТ в виде 
квантовых дисков (КД) представлен на рис. 15.3, где в изометрии и на проек-
ции изображена многорезонаторная штыревая система (МШС) с полупро-
водниковой гетероструктурой и люминофором.  

На рис.15.3,б показаны электрические силовые линии на входе МШС и 
КД на основе нитрида галлия синего свечения, возбуждающие жёлтый лю-
минофор. Длина штырей l соответствует четверти длины волны синего цвета, 
т.е. около 115 нм. Пространственный период (шаг) частотно-селективной 
структуры в 3-4 раза меньше длины l.  Точечные источники в виде КД распо-
ложены в шахматном порядке через один штырь в синфазных электрических 
полях противофазного вида колебаний (π-вида). Этот ВК, как известно из 
техники СВЧ, является наиболее устойчивым. 

 
Размеры КД (рис. 15.3,в) взяты из [11], где отмечалось, что структура с 

КТ из GaN в матрице AlN создана  на сапфировой подложке методом моле-
кулярно-лучевой эпитаксии. 
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а)                             б)                                                           в) 
  
 Рис. 15.3. Светодиодный модуль на основе многоштыревой четверть-

волновой РС (а,б) с квантовыми точками  в виде квантовых дисков КД (в). 
 
На рис.15.3,б приведены также эпюры электрического поля в МШС и в 

районе квантовых дисков. Электромагнитное поле, проникающее из МШС в 
полупро-водниковую структуру,  спадает экспоненциально и важно выбрать 
размеры штырей с интервалами между ними таким образом, чтобы получить 
максимальное электрическое поле в квантовых дисках для обеспечения наи-
более эффективного взаимодействия штыревой системы с гетероструктурой.  

Последовательность решения поставленной задачи в системе HFSS 
можно представить следующим образом. 

Командой Draw->Cilinder создадим металлический цилиндр с радиу-
сом 50 нм и высотой 200 нм.  Затем используем команду Edit-> Duplicate 
Copy для копирования и размножения штырей по координате X и по коорди-
нате Y на расстояние шага (рис. 15.4). 

 
 
Рис. 15.4. Радиус и высота штырей – переменные параметризируемые 

величины с начальными значениями 50 нм и 200 нм 
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Зададим плоскую волну, падающую на эту структуру командой Source 
-> Plane Wave. На рис.15.5 – 15.7 показаны фрагменты полей падающей, от-
ражённой и суммарной волн.   

Зададим граничные условия на окружающий этот фрагмент бокс. Для 
того, чтобы задать этот фрагмент как бесконечно повторяющийся, нужно 
задать на противоположные стороны периодические граничные условия 
Master-Slave. На нижнюю плоскость  Ground  зададим Perfect E, а на 
верхнюю плоскость – условие идеального поглощения Radiate. 

Зададим частоту расчета, например, 400 ТГц. 
 

 
Рис.15.5.  Падающая 
компонента (Incident) 

Рис.15.6. Отраженная 
компонента (Scattering) 

Рис. 15.7. Суммарное 
поле (Total) 

 
На этой частоте, после выполнения расчета, можно вывести 

падающую, отраженную компоненту и суммарное поле в сечении частотно-
селективной поверхности (рис. 15.5-15.7). 

 
Теперь добавим диапазон частот анализа командой Add Sweep. В 

появившемся по этой команде диалоге рис. 15.8 внесем оптический диапазон 
частот 100 ТГц – 1000 ТГц с шагом 20 ТГц. 

 
 

Рис. 15.8. Задание диапазона частот. 
 
Запустим расчет командой HFSS -> Analyzes All. В качестве 

характеристики отражения волны от частотно-селективной поверхности 
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можно вывести величину RCS (Radar Cross Section), которая зависит как от 
частоты, так и от угла падения плоской волны. 

Другим способом определения частотных свойств поверхности будет 
установка дискретных источников излучения в шахматном порядке, что 
позволит моделировать квантовые точки. На рис.15.9 и 15.10 показаны 
векторы рассчитанного электрического поля и источники электромагнитного 
излучения.  

 
 
Рис. 15.9. Поле Е в сечении штырей моделируемой поверхности 
 

 
Рис. 15.10. Фрагмент поверхности со штырями, на которые нанесены 

дискретные источники (квантовые точки) 
 
 

Для того, чтобы управлять возбуждением квантовых точек, заданных в 
виде дискретных источников электромагнитного излучения (рис. 15.10), 
зададим команду HFSS -> Fields -> Edit Source и установим модули 
источников возбуждения равными 1, а отсутствующие источники – равными 
0. Возбуждение структуры с помощью дискретных источников позволяет 
вывести на график параметр |S11|, который характеризует в диапазоне частот 
коэффициент отражения поверхности (рис. 15.11). 
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Рис. 15.11. Частотная характеристика отражения от частотно-
селективной шероховатой поверхности в световом диапазоне 

      Частотные  и  др.  характеристики  зависят  от  формы  штырей.  Если 
штыри  имеют  квадратные  сечения,  то    на  ребрах  концентрируется 
электрическое  поле,  что  приводит  к    увеличению  потерь  и  соответ‐
ствующему изменению резонансных характеристик. 

 

15.3.  Характеристики  светового  излучения  в 
многорезонаторных структурах 

 
    Кроме штыревой (открытой почти со всех сторон) наноразмерной 
структуры, представляют интерес  резонаторные системы различной формы, 
открытые только с одного торца, т.е. четвертьволновые ОР. Закрытые ОР 
отличаются более высокой добротностью и поэтому обеспечивают более 
эффективное излучение.  
 
     На рис.15.12 показана многорезонаторная система с четвертьволновыми 
цилиндрическими резонаторами (ЧЦР), возбуждаемыми на низших видах 
колебаний H111. Резонаторы выполнены в виде цилиндрических углублений 
в медной пластине. 
     Система состоит из цепочек связанных резонаторов (ЦСР). Квантовые 
точки (КТ) расположены через один резонатор в синфазных электромагнит-
ных полях. 
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Рис.  15.12.  Резонансная поверхность со связанными резонаторами 

 
     Расстояния между ЦСР должны быть значительно больше расстояний 
между резонаторами для исключения связи между рядами и обеспечения 
возбуждения ВК H111  с ориентацией электрических силовых линии вдоль 
ЦСР. 
      Выберем размеры в нм  и   частоты в TГц. Начертим базовую часть 
фрагмента поверхности, на которой будем создавать шероховатую 
поверхность (см. рис.15.13), командой Draw->Box. 

     
         
Рис.  15.13. Фрагмент поверхности с цепочкой связанных резонаторов 
 
    Далее начертим цилиндры высотой h=100nm и вычтем из параллелепи-
педа, составляющего фрагмент поверхности. 
 
    Возбудить такую поверхность можно падающей плоской волной 
(рис.15.14) или дискретными источниками. 
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Рис. 15.14. Поле в сечении резонансных отверстий при падении на 
поверхность плоской волны 
 
    Для того, чтобы решить задачу, охватим фрагмент поверхности 
периодическими граничными условиями (рис. 15.15), так, как было 
выполнено в главах 2-4. 

 
 

 
Рис. 15.15. Фрагмент отражающей структуры с цилиндрическими 
открытыми резонаторами (структура бесконечная, связывающая 

периодическими граничными условиями отдельный фрагмент, состоящий из 
четырех резонаторов) 

 
     Заметим, что результаты, полученные в HFSS, подтвердили, что система с 
цилиндрическими резонаторами обладает более высокой добротностью, чем 
штыревая структура. Использование цилиндрической системы будет 
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обстоятельно рассмотрено в последующих разделах. А здесь при 
рассмотрении полей вблизи шероховатых поверхностей вернёмся к 
многоштыревой системе. 
    Для вывода ближнего поля вдоль линии нужно сначала начертить эту 
линию, которую следует добавить командой Insert Near Field Setup   
в дереве проекта в разделе Radiation.  Эта линия показана на рис.15.16 для 
штыревых структур. Там же приведены векторы ближнего поля в верхних  
сечениях резонансных шероховатых поверхностей.  

 
 

Рис. 15.16. Поля в сечении резонаторов вблизи шероховатых поверхностей 
 

 

        Чтобы выполнить параметрический анализ шероховатой поверхности с 
круглыми штырями, зададим команду Optimetric. В качестве 
параметрически изменяемых переменных выберем высоту штырей от 60 нм 
до 220 нм. На рис.15.17 приведены резонансные характеристики, полученные 
для разных высот цилиндрических штырей. 
 

 
Рис.  15.17. Частотные характеристики структуры (на отражение) для 
разных высот цилиндрических штырей 

     На  основании  экспериментальных  расчетов  подтверждено,  что 
максимум электрического поля достигается в верхнем сечении штырей 
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и    РС.  Эпюра  электрического  поля и  электрические  векторы показаны 
на рис.15.18.  
 

 

а) РС, состоящая из круглых 
стержней. 

б) РС, состоящая из прямоугольных стержней. 

Рис.  15.18.  Многоштыревые  структуры  с  круглыми  (а)  и 
прямоугольными (б) стержнями.  

   Для  структуры,  показанной  на  рис.  15.18,    а  с  круглыми  штырями, 
приведем  результаты  расчета  рабочей  полосы  частот  и  добротностей, 
которые получены в HFSS для материалов с разными проводимостями, а 
также шероховатостями.  
 

 
Рис. 15.19. Диалог задания граничного условия материала с конечной 
проводимости, в котором можно ввести в виде дополнительного 
параметры шероховатость (Surface Roughness) поверхности материала.  
 
 

Медь  Медь  с  Молибден   Вольфрам 
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σ=5.8∙107 См/м  шероховатой 
поверхностью 
 

σ=1.76∙107 См/м  σ=1.85∙107 См/м 

100 ТГц  200  250  220 

Q=10  5  4  4.5 
         
Следует отметить, что значения добротностей, приведенные в таблице, 

являются слишком малыми. Поэтому далее вместо открытой 
многоштыревой структуры рассмотрим другие резонаторные системы с 
более высокими добротностями. При этом будем обращать внимание на 
возможности использования низших ВК и обеспечивать такие размеры 
резонаторов, чтобы резонанс фундаментального ВК соответствовал 
максимуму  спектра излучений активной среды, в качестве которой в данном 
случае предполагается использование квантовых нитей и точек. 

  
 

15.4. Моделирование резонансной структуры со 
стабилизирующими резонаторами 

 
    В технике СВЧ часто применяются стабилизирующие резонаторы, 
которые влияют на открытый резонатор так, что собственная резонансная 
частота становится более стабильной за счёт увеличения собственной 
добротности всей резонаторной системы [8]. Это явление можно применить 
при создании сложной поверхности, работающей в оптическом диапазоне 
волн.  
В качестве первого примера использования стабилизирующего резонатора 

рассмотрим резонаторную систему, состоящую из двух четвертьволновых 
цилиндрических резонаторов, связанных со стабилизирующим 
полуволновым призматическим резонатором. Эта система в виде триады с 
синими, зелёными и красными КТ показана на рис.15.20. В цилиндрических 
резонаторах возбуждаются противофазные колебания на низших видах Н111, 
которые поддерживаются и стабилизируются видом колебаний Н103 в 
стабилизирующем резонаторе, созданном на основе прямоугольного 
волновода с волной низшего типа Н10. 
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Рис. 15.20. Система в виде триады, состоящей из четвертьволновых 

цилиндрических резонаторов с призматическими 
стабилизирующими резонаторами. 

 
В системе используются щели связи по магнитному полю, расположенные 

на расстоянии, составляющем половину волноводной длины волны в 
призматическом резонаторе. 

 В качестве активного элемента предполагается использование квантовой 
точки (КТ) в виде наноразмерного диска диаметром t, расположенного 
между четвертьволновыми цилиндрическими резонаторами в максимуме 
электрического поля (рис. 15.21). 
    Размеры стабилизирующего резонатора для синей, зелёной и красной длин 
волн (λ1 = 460 нм,  λ2 = 525 нм и λ3 = 635 нм) определяются по формулам, где  
и b <  (обычно). 
   Например, при 250 нм  получаем d1=304 нм, d2=362 нм и d3=482 нм. 
     Затем, исходя из  выражения для и ,  
находим  а1=302 нм, а2=341 нм и а3=396 нм; после чего выбираем b1=150 нм, 
b2=170 нм и b3=200 нм. 
    Протяжённости стабилизирующих резонаторов с ВК Н103 на основании 
выражения  получаем равными   L1=1062 нм, L2=1235 нм и L3=1596 нм. 

 Анализ излучателей в системе HFSS позволяет также получить  
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пульсирующую картину электромагнитного излучения в динамическом 
режиме. Результаты анализа излучения из одной квантовой точки 
рассмотренного ОР в системе HFSS иллюстрируются на рис.15.20, где 
показано поле в фиксированный момент времени.   

 
Рис.15.21. Картина излучения из КТ в фиксированный момент времени 

 
А на рис.15.22 зафиксировано излучение в тот момент, когда в щелях 

связи максимальное электрическое поле, а вблизи КТ минимальное из-за 
расстояния в четверть длины волны. 

 

     
  
                             а)                                                                  б) 

Рис.15.22. Излучение из КТ (а) в момент времени, когда в щелях связи 
максимальное электрическое поле (б) 

 
Необходимо отметить, что из техники СВЧ известны более 

высокодобротные стабилизирующие резонаторы, чем призматические на ВК 
Н10р. К ним, например, относятся цилиндрические резонаторы на основе ВК 
Н01р, которые будут рассмотрены в следующем разделе. 
 

15.5. Квантовые нити и точки над резонаторами 
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15.5.1. Резонаторные системы с квантовыми нитями на ламелях 

 
Рассмотрим пример наиболее высокодобротного СР, основанного на 

уникальной особенности волны типа Н01 в круглом волноводе, при 
распространении которой потери в стенках волновода чрезвычайно малы. Из 
техники СВЧ также известно, что используемые в коаксиальных 
магнетронах СР на видах колебаний Н011 дают увеличение собственной 
добротности многорезонаторной системы почти на порядок [11,12]. В связи 
с этим  предлагается использовать идеи, реализованные в обращённо-
коаксиальных и торцевых стабилизированных магнетронах (ОКМ и ТСМ), 
для создания наноразмерных излучателей.  

Один из этих вариантов относится к излучателю кругового действия, 
который можно представить, как аналог ОКМ. Так, на рис.15.23  приведена 
схема излучателя в виде обращённой системы ламельного типа, 
возбуждаемой на π-виде колебаний от азимутально-симметричного вида Н011 
во внутреннем цилиндрическом резонаторе с помощью ЩС, расположенных 
через один резонатор.  

 
 

Рис. 15.23. Излучатель кругового действия (аналог ОКМ) 
 

На концах ламелей (Л) тоже через одну Л расположены квантовые нити 
(КН) длиной не более ширины Л. Размеры Л по ширине и длине составляют 
менее четверти длины волны излучаемых колебаний, а длины СР с синими, 
зелёными и красными КН в данном случае могут быть взяты примерно 
равными 290, 370 и 620 нм при одинаковых диаметрах резонаторов по 900 
нм. 

 
Другой вариант представляет СДМ осевого излучения с СР на виде 

колебаний Н011 как аналог ТСМ (рис. 15.24).  
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Рис.15.24.  Излучатель с квантовой звёздочкой (аналог ТСМ) 
 

В отличие от излучателя  кругового действия здесь Л и ЩС находятся на 
торцевой поверхности СР с видом колебаний Н011. На концах Л (чётных или 
нечётных) расположены КН одного цвета. И такие радиальные КН на 
торцевой поверхности могут восприниматься как «квантовые звёздочки».  
[18,19].Рассматриваемая конструкция удобна для нанесения люминофорного 
покрытия, состоящего из зёрен люминофора (ЗЛ), размеры которых могут 
быть сравнимы с шириной Л. Жёлтые люминофоры в сочетании с синими 
КН обеспечивают белое свечение. При этом целесообразно использовать 
отражатель для получения желательного светораспределения излучателя.  

Излучатели, представленные на рис.15.23 и 15.24, были 
проанализированы в системе HFSS. Расчётные резонансные характеристики 
подтверждают возможность увеличения собственной добротности при 
введении СР.  

На рис. 15.25 и 15.26 приводятся иллюстрации, полученные в системе 
HFSS при анализе второго резонатора с квантовыми звёздочками на ламелях.  

                    
    
                                       а)                                                                       б) 
Рис. 15.25. Резонаторная система с торцевыми ламелями в изометрии (а) и 
в плане (б). 
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Рис.15.26.  Излучение из квантовой звёздочки в фиксированный момент 

времени. 
 

 
15.5.2. Резонаторные системы с квантовыми  

кольцами 
   Можно представить и более простые устройства излучателей, 
использующих «квантовые колечки». Один из таких излучателей показан 
схематически на рис. 15.27.  

 
Рис.15.27. Излучатель с квантовым колечком. 
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    Этот излучатель в некоторой степени является аналогом ячеек, 
приведенных на рис. 15.19. В нём используется несколько четвертьволновых 
цилиндрических резонаторов (например, четыре), расположенных по 
окружности. В данном примере в этих резонаторах возбуждаются   
синфазные колебания видов Н111, связанные через щели связи (ЩС) со 
стабилизирующим резонатором на основе полуволнового круглого 
волновода с видом Н01р (на рисунке показаны силовые линии вида колебаний 
Н012). Вместо КН в представленную ячейку введено синее квантовое колечко 
(СКК), расположенное в своей матрице (М) вдоль электрических силовых 
линий. Таким образом, излучающим элементом в данном излучателе 
является как бы КН, свёрнутая в кольцо. 
    На рис.15.28 приведена картина электромагнитного поля в резонаторной 
системе и в ближней зоне излучателя в фиксированный момент времени, а 
также частотная характеристика резонаторной системы без 
полупроводниковой структуры, которые были получены в  HFSS. 
 
 

 
 
Рис. 15.28. Частотная характеристика и картина электромагнитного поля 

на рабочей частоте 650 ТГц 
 
    Из рис.15.28 видно, что в диапазоне частот от 500 до 1000 ТГц  получено 
несколько резонансных характеристик, одна из которых соответствует 
резонансу ВК Н012 в СР на частоте 650 ТГц. Подтверждением этому факту 
является картина с двумя вариациями поля вдоль оси СР.  
   Заметим, что ВК Н012 не является низшим, и поэтому наблюдаются 
резонансы на более низких частотах. Однако разделение ВК вполне 
достаточное для того, чтобы не возникало «паразитных» колебаний, 
снижающих эффективность излучения на рабочей частоте.  
Следует обратить внимание на то, что резонансная характеристика РС с СР 
на ВК Н012 является наиболее узкой, что свидетельствует о высокой 
добротности РС на рабочей частоте. 
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На рис.15.29 приведена картина поля в момент времени, когда в щелях 

связи  электрическое поле достигает максимального значения, а вблизи КК  
при этом нулевое поле, поскольку КК находится на расстоянии в четверть 
волны от ЩС.  
На рис.15.29 также приведено распределение азимутальной составляющей 

электрического поля в радиальном направлении, т.е. вдоль линии, 
показанной на рисунке. Азимутальная составляющая электрического поля на 
ВК Н01р является единственной и кривая, соответствующая рабочей частоте 
650 ТГц, показывает, где расположен максимум электрического поля и куда 
следует поместить КК. 
  
 

 
Рис.15.29.  Распределение электрического поля в радиальном направлении и 
иллюстрация излучения в момент времени, когда в щелях связи 
максимальное электрическое поле. 
 

Заметим, что поперечные размеры рассмотренного излучателя 
ограничены диаметрами четвертьволновых резонаторов, которые не должны 
превышать 0,6 λ, чтобы они допускали возникновение только низшего ВК 
Н111, и диаметром СР, который не должен быть существенно больше 1,2 λ, 
чтобы не возникало множество высших ВК.  

Это обстоятельство находится в противоречии с необходимостью 
обеспечения достаточных технологических размеров для изготовления 
эффективных полупроводниковых структур на основе КТ из InGaN в матрице 
GaN [19]. Поэтому, желательно увеличить размеры матрицы с КТ. 

Для этого предлагается устройство излучателя, схематически 
представленного на рис.15.30, в котором используется коаксиальный СР, 
возбуждаемый на виде колебаний Н011 и расположенный внутри 
многорезонаторной системы, состоящей из цилиндрических 
четвертьволновых резонаторов (ЧР) с видами колебаний Н111. На рис. 15.30 
показаны 8 резонаторов с противофазными колебаниями при связи с СР 
через один ЧР. Над этими резонаторами расположена дисковая матрица 
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(ДМ) с КТ. Расчётные размеры резонаторов для синих и красных КТ в 
соответствии с обозначениями на рис.15.30 приведены в таблице.  

 
  Таблица. Размеры (в нм) излучателя, представленного на рис.15.30. 
Цвет Длина 

волны 
Dчр Dср d h 1 h 2 Dм 

Синий 460 340 680 100 555 370 1360 
Красный 640 480 960 140 750 755 1920 

  
 

 
 

 
     

Рис. 15.30. Излучатель с коаксиальным стабилизирующим резонатором. 
 

 Для обеспечения наиболее эффективной электромагнитной связи между 
СР и ЧР их размеры следует подобрать таким образом, чтобы отрезки 
волноводов, из которых получены резонаторы, имели одинаковые 
критические и соответственно волноводные длины волн, т.е. h 1 = 3/4λв и h 2= 
λв/2. 

Устройство рассматриваемого излучателя удобно тем, что диаметр 
матрицы Dм можно  увеличивать за счёт увеличения количества ЧР. При 
этом с увеличением диаметра Dср необходимо будет соответственно 
увеличивать диаметр стержня d для сохранения резонансной частоты.                               

Подводя итоги рассмотрения предлагаемых излучателей отметим, что 
световой поток одного такого наноразмерного устройства очень мал, и эти 
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излучатели следует собирать в массив. Каждый излучатель при этом может 
дополняться отражателем.  Такие излучатели могут группироваться, 
например, в полноцветные (синие, зелёные и красные) триады. Полученное 
светоизлучающее устройство может быть использовано как источник света с 
регулируемой цветностью хроматического или белого излучений, а также 
применяться в дисплеях с высокой разрешающей способностью. 

Световая отдача излучателя с синими КН в сочетании с жёлтым 
люминофором во многом зависит от собственной добротности 
многорезонаторной системы, настроенной на частоту синего цвета. При 
использовании цветовых триад без люминофоров световая отдача каждого 
цветового элемента также существенно зависит от добротности  и настройки 
многорезонаторной системы со стабилизирующим резонатором на длину 
волны, излучаемую квантовой звёздочкой или квантовым колечком. 
 

15.6. Анализ структуры, составленной из восьми 
резонаторов в оптическом диапазоне длин волн 

 
    Рассмотрим этапы анализа резонаторной структуры оптического 
диапазона длин волн в системе HFSS на примере излучателя, 
представленного на рис.15.30.  
   На первом этапе осуществляется черчение и создание конструкции 
резонатора. Выберем единицы черчения «нм»  и  частот «TГц». 
 
Для синего света λс = 460 нм  
D =1.5 мкм, Dс = 750 нм, d =100 нм, Dч=380 нм, lч=490 нм и  lс=325 нм;  
 
для красного  λк = 640 нм   
D=2.1 мкм, Dс =1050, d=150 нм Dч=525 нм, Длиныч  = 675 нм,  lс=450 нм. 
 
Длина щели связи: 400 нм. 
 

Резонаторная структура с указанными размерами и квантовым колечком, 
выполненная графическими средствами HFSS, показана на рис.15.31 в 
изометрии и в плане.  
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Рис.15.31.  Структура, в которой щели расположены через один внешний 
резонатор, т.е. связаны с центральным коаксиальным резонатором 1,3, 5, и 
7 внешние цилиндрические резонаторы 
 
     Создание этих рисунков выполнено при использовании следующих 
команд.  Начертим базовую структуру резонатора командой Draw-> Box 
(рис.15.32). 
 

 
Рис.15.32. Размеры базового металлического бокса 

 
   Далее в этом боксе нужно вырезать один центральный цилиндр радиусом 
525 нм и 8 цилиндров радиусом 262.5 нм. 8 резонаторов размещены так, что 
между центральными боковыми располагается щель связи (рис.15.33 и 
15.34). 
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Рис. 15.33.Центральный цилиндр Рис.15.34. Малые цилиндры 
 
    Командой Edit->Duplicate->Around Axis  дублируем цилиндры вокруг 
оси и умножаем на 8.  
     Далее начертим внутренний стержень, расположенный вдоль оси Z 
(рис.15.35) 

 
Рис.15.35.  Размеры внутреннего металлического стержня. 

 
    Далее на высоте 400 нм начертим колечко, вычитая один цилиндр из 
другого (рис.15.36 и 15.37). 

Рис.15.36. Размеры внешнего 
цилиндра. 

Рис.15.37. Размеры внутреннего 
цилиндра. 

 
    В результате вычитания получаем планарное кольцо шириной 20 нм. 
Установим граничные условия Perfect E на квантовое колечко. Чтобы 
вставить в это кольцо 8 портов, которые будут возбуждать 
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последовательный ток в  кольце, прорежем в планарном кольце 8 
прямоугольников, размер первого из которых соответствует рис. 15.38.  
 

 
Рис. 15.38.  Координаты прямоугольника в разрыве квантового колечка, на 
который устанавливается  дискретный порт.  
 
     Создав этот прямоугольник, зададим на него дискретный порт командой 
HFSS->Exitation-> Assign Lumped Port и задавая импедансную линию 
посередине этого прямоугольника. Далее выполним дублирование этого 
прямоугольника с сохранением граничных условий относительно оси Z. 
 

 
 
          Рис.15.39.  Диалог дискретного порта, поставленного в разрыв 
квантового колечка. 
 
   Созданную структуру, показанную на рис. 15. 31 охватим боксом, 
созданным по команду Draw->Box, размеры которого в нанометрах указаны 
на рис. 15.40.  
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Рис.15.40. Размеры бокса Radiate. 

 
 На этот параллелепипед установим граничные условия излучения, а на 
боковые стенки – периодические граничные условия Master-Slave на 
противоположные стенки бокса излучения (рис. 15.41). 
   

 
 
 
Рис.15.41. Постановка периодических граничных условий Master-Slave на 
противоположные стороны бокса, охватывающего одну ячейку резонатора. 
 
    Выполним установку на расчет командой HFSS-> Analysis setup->Add 
Solution Setup. Центральная частота 467 ТГц соотв. длине волны 640 нм (рис. 
15.42). 
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Рис.15.42.  Задание центральной 
частоты анализа 

Рис.15.43.  Задание полосы частот 
(режим интерполяции) 

  
    Заметим, что если квантовые точки будут расположены равномерно в 
квантовом колечке, то они будут возбуждаться противофазно в соответствии 
с полями в цилиндрических резонаторах. Картина излучения в этом случае 
представлена на рис.15.44 и 15.45. 
 

 
 
Рис.15.44. Излучение электромагнитной волны оптического диапазона из 

квантового колечка в системе с внутренним коаксиальным 
стабилизирующим резонатором 
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Рис.15.45.  Ближнее поле в сечении резонатора  при установке 

противофазного возбуждения квантовых точек. 
 
     На рис.15.46 приведена частотная характеристика, а на рис.15.47 - 
картина электромагнитного поля при возбуждении КТ, расположенных в КК 
через один резонатор. 
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Рис. 15.46. Частотная характеристика S11 по каждому порту, внедренному 

в КК (8 портов) 
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Рис.15.47. Картина электромагнитного поля при возбуждении КТ, 
расположенных в КК через один резонатор 

 
  Анализируя динамическое движение картины электромагнитного поля, ко-
торое рассчитывается, изменяя фазу источника возбуждения, можно видеть, 
как взаимодействуют электромагнитные поля, излучаемые от отдельных ре-
зонаторов, общую картину поля и типы волн, которые резонируют в отдель-
ных полостях цилиндрических резонаторов. 
 
Выводы. Рассмотренные  варианты СДМ на основе ОР с квантовыми 
точками, звёздочками и колечками ни в коей мере не ограничивают 
разнообразия этих устройств. Не трудно представить и другие 
конструктивные варианты СДМ на основе четвертьволновых 
многорезонаторных систем с другими видами колебаний, в том числе и с 
разнообразными высокодобротными стабилизирующими резонаторами.  

В настоящее время представление излучателей в виде квантовых звёздо-
чек и колечек могут показаться нереально фантастическим, и моделирование 
таких источников  еще требует многостороннего экспериментального под-
тверждения.  Однако прогресс теоретического анализа перспективных нано-
материалов и успехи нанотехнологии показывает, что это будет реализовано 
в недалёком будущем.         

Многочисленные публикации, в которых показано использование 
HFSS показывают, что ее можно успешно применять для оптимизации 

структуры светодиодного модуля. Можно с уверенностью утверждать, что 
поиски оптимальных решений при создании СДМ на основе элек-

тродинамических систем с квантовыми точками позволят существенно 
улучшить параметры световых приборов с наноразмерными источниками из-

лучений.
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16. Установка конфигурации для распределенного 
расчета на нескольких компьютерах 

        

   HFSS -13 имеет возможность решать задачи огромного размера, когда 
число  тетраэдров разбиения может достигать многих сотен тысяч. 

     В последние 10 лет наблюдался огромный  прогресс в усилении 
компьтерных средств для решения больших задача - от создания больших 
вычислительных серверов,  до распределенных кластеров и 
многопроцессорных настольных рабочих станций. Параллельно шло 
улучшение математических алгоритмов и программ их реализации. На рис. 
16.1 показываются вехи прогресса в расчете физических задач, в 
механическом анализе, и в решение электродинамических задач поля  
Ansoft. В настоящее время считается, что применение HFSS в процессе 
проектирования на 15% ускоряет процесс разработки новых изделий от идеи 
до воплощения в железе.  

 

Рис. 16.1. История роста характеристик производительности системы HFSS 
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     Один из способов увеличить производительность состоит в параллельном 
моделировании. Из рис. 16.1. видно, что  в 1998-1999 можно было решить 
систему уравнений в 10M ячеек. В 2004  HFSS Ansoft решал структуру с 
100M ячейками. Сегодня ANSYS может анализировать структуру с 1 
миллиардом ячеек, и уровень точности моделирования очень высокий.  
 
  В настоящее время ключевым является новый метод, для реализации 
которого необходимо иметь специальную лицензию High Performance 
Computing  (HPC). 
     Этот  метод позволяет реализовать 2 подхода к расчету: 
 
       1) Domain Decomposition, 
       2) Multi-processing. 
 
     Решение методом HPC сводится к мультипроцессному расчету, используя 
опции распределенного расчета, которые могут объединить до 100 ядер 
мультипроцессора. Заметим, что далее в этом разделе термин 
«вычислительная машина» может относиться к персональному, а также 
супер-компьютеру. Ядры и процессоры могут характеризовать любую из 
этих машин. 
 
      Начиная с HFSS v.12, компания Ansoft  развивает метод HPC используя 
метод декомпозиции задачи. Метод MP (multi-processing) был реализован в 
HFSS-7.  Опция распределенного решения DSO реализована начиная с 
HFSS-10. Эти опции используются уже сегодня, чтобы уменьшить время 
моделирования от дней до часов, позволяя инженеру выполнить 
многократные моделирования в течение одного рабочего дня.   Для этого 
были разработаны и предложены специальные методы мультипроцессорного 
и мультикомпьютерного расчета  HPC и реализованы дополнительные 
улучшения в HFSS v.12 (улучшенное разбиение на сетку и смешанные 
порядки элементов разбиения) для существенного увеличения  
производительности. 
 
    Поясним термины, которые пришли в проектирование вместе с усилением 
мощности численного моделирования. 
 

1. HFSS HPC –  новая опция, появившаяся  в HFSS 12 
     HPC = High Performance Computing 
 
2. Enables Domain Decomposition, метод декомпозиции - новый метод 
     решения в HFSS 12. DDM = Domain Decomposition Method. Новый 
      метод DMP в HFSS. DDM - это метод высокого запараллеливания, 
причем: 

– это метод объединения памяти и ядер ряда компьютеров с 
помощью сети; 
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– DDM реализует значительное увеличение памяти для больших и 
очень больших задач; 

– DDM обеспечивает быстрое решение, используя большое 
количество процессоров. 

 
     3. Multi-Processing - многопроцессорный метод параллелизации разде- 
         ляемой памяти, введенный в HFSS 7.    MP = Multi-Processing 

– “Традиционный” многопроцессорный SMP. 
 
    4. Необходимое количество лицензий “ HPC licenses ” для моделирования 
зависит   от числа ядер, которые требуются для расчета. 

5.  Работа в режиме пакета (Packs) или " плавающем (pool) " режиме. 
 

– Packs позволяет использовать заданное число ядер для 
программы; 

– “Pool” лицензии позволяют использовать любое число ядер, 
управляемых мульти-серверами. 

 
• SMP = Shared Memory Parallel. 
• DMP = Distributed Memory Parallel. 

 
• DSO = Distributed Solve Option - много-параметрическое (геометрия, 

частота) параллельное моделирование. 
• RSM = Remote Simulation Manager - новая  управляющая программа 

распределенного анализа, появившаяся в HFSS v12, предназначенная 
для работы компьютера  в сети 

 

 
Примеры расчетов, которые выполнены, используя 

лицензию HPC 
 

    Пример 1.  Антенна расположена на военном автомобиле 
Хаммер.  Задача электромагнитной совместимости решается на частоте 
1.8GHz и имеет размер > 7500λ3   (где λ - длина волны на рабочей 
частоте, м)  и использует: 

• Базисные функции второго порядка (2nd order);    
• 730,000  тетраэдров; 
• 14M неизвестных в матрице (это даже мало, для использования метода 

DDM); 
• Выполнение расчета с помощью трех связанные группы компьютеров; 
• Общая память=115 GB. 
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Рис.  16.2. Пример расчета структуры антенны на движущемся объекте  
 
    Результаты расчета пространственной диаграммы направленности показа-
ны на рис. 16.2. 
 

Пример 2. Антенна, смонтированная на корпусе истребителя F-
35.    Анализируемая щелевая антенна (рис. 16.3) находится в крыле внизу 
фюзеляжа самолета  
• F-35 Joint Strike Fighter: UHF blade antenna @ 350 MHz 
• Размер задачи = 1400λ3 

 

 

 

 

Рис. 16.3. Военный истребитель F-16 с антенной 
внизу фюзеляжа 

Рис.16.4. Щелевая антенна 

 

При решении этой задачи используется метод DDM. 
• DDM подобласти разбиваются на сетку разбиения в маленьких 

подобластях “sub-domains” так, что поле в них рассчитывается 
параллельно на нескольких компьютерах. Для этого выполняется: 

– Выбор узла “master” итерационного солвера для общего решения 
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– Автоматическое разбиение области решения на подобласти 
• Пользователь определяет набор N доступных компьютеров для 

использовании методом  DDM: 
– n=1  это узел “master”, одно ядро; 
– n=2 до  N это узлы подобластей решения по сравнению с прямым 

решением. 
 
 

 
Рис. 16.5. Разбиение пространства расчета на тетраэдры, области и 

подобласти 
 
Результаты расчета совпадают, при решении непосредственно 

программой HFSS, и при использовании метода DDM. Однако время 
расчета значительно отличаются. 
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Рис. 16.6. Сечение диаграммы 
направленности антенны на 
корпусе самолета 

Рис. 16.7. Пространственная 
диаграмма направленности 

 
 
 
 

 

 
Рис. 16.8. Частотная 
характеристика 

Рис. 16.9. Время расчета в 
зависимости от количества 
областей разбиения 

 
 
 

Пример 3:   Двухзеркальная параболическая антенна (рис. 
16.10) создана по схеме Коссегрена. Размер  задачи  ~17,500 λ3 . 

 

   Время решения   на 8-ядерном компьютере 22049 сек.  Решение ускоряется 
в 17-24 раз при использовании лицензии HPC. 
 



  227

 
Рис. 16.10. Двухзеркальная параболическая антенна 

 
    В таблице рис. 16.11. приведены машинные ресурсы, затрачиваемые при 
моделировании двухзеркальной параболической антенны, которые зависят 
от числа ядер. И ускорение процесса решения задачи при включении 
дополнительных ядер. Видим, что ускорение доходит до шевти по 
сравнению с базовой конфигурацией с 8 ядрами.  Отметим, что ускорение 
расчета по сравнению с работой на одном процессоре выполнить 
невозможно. 
 
 

 
Рис. 16.11. Компьютерные ресурсы, требуемые при решении двухзеркальной 
антенны. Ускорение Speed-up по сравнению с базовым компьютером с  8 
ядрами 
 
   
    Для решения подобных задач необходимо установить менеджер 
удаленного моделирования RSM (Remote Simulation Manager). Эта 
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программа инсталлируется как отдельная программа и автоматически 
создает удаленные или связанные в сети моделирования в режиме связи  
“links”. 
  

• Метод нового распределенного анализа для работы с удаленными 
компьютерами 

• Активизирует возможности решающего устройства в режиме DDM, 
DSO и в режиме решения на удаленных компьютерах. 

     

Установка конфигурации распределенного расчета. 
 Чтобы создать новую конфигурацию распределенного расчета на нескольких 
компьютерах: 

1. Кликните  HFSS или HFSS-IE>Tools>General Options чтобы вывести 
диалог General Options и выбрать закладку  Analysis Options.  

 

Рис. 16.12. Диалог опций HFSS 

2. Выберите закладку  Analysis Options, и в разделе  Analysis Machine 
Options, выберите опцию Distributed.  Эти изменения будут показаны в 
закладке Analysis Machine Options и покажут панель для просмотра и 
редактирования конфигурации компьютеров (рис. 16.13). 
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Рис. 16.13. Опции анализа  компьютеров в сети 

3. Кликните кнопку Edit Distributed Machine Configurations. 

 

Рис. 16.14. Диалог конфигураций распределенного расчета 

   Это выведет диалог Distibuted Machines Configurations (рис. 16.14). Этот 
список существующих конфигураций показывает все машины и выбранные 
конфигурации, а также информацию, заблокированы они или нет. Здесь вы 
можете добавить новую конфигурацию нажимая Add, отредактировать  
конфигурацию командой  Edit, удалить выбранную конфигурацию командой 
Delete, или дублировать существующую конфигурацию командой Clone, 
обычно редактируя имя и содержание конфигурации.  

4. Чтобы создать новую конфигурацию, кликните  в диалоге рис. 16.14 
кнопку Add.  

Это открывает диалог Distributed Analysis Machines (рис. 16.15). Нажатие 
Edit или Delete также открывает диалог Distributed Analysis Machines, но 
включает имеющиеся выбранные конфигурации.  
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Рис. 16.15. Диалог списка машин, используемых в распределенном расчете 

 Здесь вы можете отредактировать имя конфигурации, вид, добавление, тес-
тирование и блокирование машин в списке.  

5. Задайте имя конфигурации. Он не может быть пустым и не может иметь 
ранее заданное или зарезервированное слово. 

6. Для каждой машины чтобы вручную добавить список, under Remote 
Machine details, задайте адрес IP , имя DNS или имя  UNC. Вы можете также 
использовать Import Machines from File... для использования текстового 
файла для упрощения процесса. 

 

Рис. 16.16. Раздел, в котором включаются машины в список 

   Кнопки управления позволяют добавить машину в список командой Add 
machine to list (рис. выше) или удалить командой Remove (рис. ниже) 
машины из списка.  
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     Каждая машина в текущем списке имеет окно Enabled.  Вы можете 
заблокировать или подключить любые машины в списке по вашему 
желанию. Сверху таблицы, диалог позволяет учитывать общее количество 
машин, и это число может быть включено или заблокировано. 

 
Рис. 16.17. Блокирование и включение машин в распределенный расчет 

 
   В общем случае, HFSS и HFSS-IE используют машин в распределенном 
списке машин анализа в порядке, в котором они появляются. Если выбран 
Распределенный метод расчета, и Вы запускаете несколько расчетов от того 
же самого интерфейса, то HFSS и HFSS-IE выбирают машины, которые 
выполняют наименьшее количество компьютеров в порядке, в котором 
компьютер находятся в списке. Например, если список содержит 4 машины, 
и Вы запускаете моделирование, которое требует одну машину, HFSS 
выбирает первую машину в списке. Если другое моделирование запущено, в 
то время как выполняется предыдущее, и это моделирование требует две 
машины, HFSS выбирает машины 2 и 3 из списка. Если первое 
моделирование тогда завершается, и мы запускаем другое моделирование, 
требующее три машины, HFSS выбирает машины в порядке 1, 4, и 2. 
 
   Отображенный список всегда показывает порядок, в который Вы ввели их 
независимо от загрузки на машинах. Чтобы управлять порядком в списке, 
выберите один или большее количество машин, и используйте кнопки Move 
up  или  Move  down. Передвижение вверх и вниз  допускаются, когда Вы 
выбираете один или большее количество смежных имеет машин. Также, 
когда Вы выбираете один или большее количество имен машин, Вы будете 
видеть поле текста ниже управления сети, показывая сначала имя машины, 
сколько раз она появляется, допускается, и заблокирована.  
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Рис. 16.18. Передвижение машин в списке для изменения 

последовательности их включения 
 
7.  Test  Machines‐  Когда несколько пользователей в сети используют 
распределенное дистанционное решение, нужно проверить состояние этих 
машин перед запуском моделирования, чтобы убедиться, что никакие другие 
процессы Ansoft не запущены. Чтобы сделать это, вы можете выбрать одну 
или большее количество машин в диалоге (рис. 16.18) и нажать кнопку Test 
Machine.   Открывается диалог Test Machines. После тестирования дается 
отчет относительно состояния каждой машины.  
     Тестирование можно выполнить и над группой машин, включенных в 
распределенных расчет. Включить или выключить машины можно в списке 
диалога рис. 16.18. 

8. Кликните OK, чтобы сохранить изменения и закрыть диалог Distributed 
Analysis Machines.  Только машины, отмеченные как Enabled  появляются в 
списке распределенных машин в закладке Analysis. 

     Независимо от машины, на которой фактически выполняется анализ, 
числа процессоров и установки Desired RAM Limit, и заданных по 
умолчанию параметров настройки приоритета процесса теперь читается из 
машины, из которой Вы запускаете анализ.  

   Если конфигурация установлена, то ее можно выбрать на инструменталь-
ной панели, выбирая значки: 

 
Рис. 16.19. Кнопки на панели HFSS, позволяющие оперативно переключать 
режим локальной, удаленной и распределенной работы  
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   Заметим, что эта опция активна только в том случае, если имеются 
несколько машин для распределенного анализа. Режим распределенного 
анализа рекомендуется использовать в том случае, если не достаточно 
ресурсов одного компьютера.  
     На одном компьютере HFSS работает следующим образом. Сетка - по 
существу большая матрица, которая должна быть инвертирована и решена. 
HFSS пытается сделать всё это в RAM. Как только доступная RAM 
исчерпана, HFSS начинает    разделять матрицу на части, в которых 
некоторые матричные элементы записываются на жесткий диск, и другие 
части сохранены в RAM. Однако имеется минимальный размер матрицы, 
которая должна быть сохранена в RAM, и должно остаться пространство в 
памяти, чтобы была возможность инвертировать и решить матрицу. Если 
матрица является настолько большой (т.е. сетка разбиения очень плотной), 
что этот минимальный размер больше не помещается в RAM, HFSS 
остановится. 
      Пользователь имеет два несколько вариантов действий.  
    Он может 1)увеличить RAM компьютера, или 2)может использовать 
итерационное решающее устройство, или 3) использовать лицензию, и 
соответственно метод HPC, чтобы решить проблему.  Рекомендуется  
использовать итерационное решающее устройство. Использование  опции 
Iterative Solver может резко уменьшить требования RAM. 

        Правила использования итеративного солвера 
 
1. Итерационное решающее устройство работает более эффективно, когда 
структура не содержат много источников возбуждений. (Например, число 
возбуждений – меньше, чем удвоенное число процессоров.) 
 
 2. Если вы хотите использовать преимущество итерационного решающего 
устройства, и ваш анализ включает расчет на многих дискретных частотах, 
адаптивное решение должно лучше сходиться на самой высокой частоте  в 
полосе частот.  
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Рис. 16.20. Раздел Solution Options, включающий выбор порядка базисной 
функции и параметров итеративного солвера 

3.  Relative Residual обеспечивает критерий остановки. Разность оценивает 
итерационного решающего устройства при решении матричного уравнения. 
Значение действует на характеристики  итерационного решающего 
устройства следующим образом: 
 
• По умолчанию она равна 1E-4. Это дает точные S-параметры и поля, 
неотличимые от полученных обычным расчетом. Ansoft рекомендует 
устанавливать эту величину Residal. 
 

•  При большей величине Residual, например, 1E-3 или 1E-2, итеративный 
процесс остановится с меньшим количеством итераций, и решение будут 
меньше сходиться. S-параметры  не будут отличаться много от результатов, 
полученных прямым решением, например, разница в третьей или второй 
цифре. Поля и диаграммы направленности антенны - визуально те же самые. 

 
•   Величина Residual = 0.1 может использоваться для быстрого адаптивного 
измельчения сетки рано в адаптивном процессе, но S-параметры будут 
заметно отличаться. 

• Величина Residual =1  не должна никогда использоваться. В окно не 
имеется  возможность ввести величину Residual  больше 0.1. 

    Выбор порядка базисных функций. В HFSS-13 можно выбрать 
базисные функции  HFSS используя интерполяцию величин поля между 
узлами тетраэдров. Для этого в разделе Options  диалога Solution Setup  
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выбирается опция Order of Basis.    Это может быть Zero Order, First Order 
(по умолчанию), Second Order, или Mixed order.   Опции Order of Basis  
влияют на уплотнение сетки по критерию Lambda Refinement и выбираются 
следующим образом. 

   Опция с нулевым порядком (Zero Order)  полезна, когда модель 
разбивается на сетку с более чем 100 000 тетраэдров, но размер модели 
является маленьким по сравнению с длиной волны. Более высокие порядки  
увеличивают количество неизвестных для каждого тетраэдра и 
используются, когда требуется большая точность расчета поля.  Если вы 
выбираете Zero Order Solution Basis, все тетраэдры в модели должны иметь 
длину ребер меньше, чем 1/20 длины волны.  

 
        Опции установки при работе на одном компьютере 
 

 
Рис. 16.21. Опции расчета компьютера, работающего самостоятельно 

 
   Для многопроцессорной обработки, выберите опцию Enable 
multiprocessing using HPC licenses.  Эта опция позволяет  использовать 
лицензии HPC, включающие многопроцессорную обработку. 
    Требования к RAM растут линейно с увеличением размера модели. При 
использовании итерационного решающего устройства также имеет место 
линейное увеличение требований к RAM. Если вы используете базовый 
солвер, требования к RAM увеличиваются нелинейно. 
   Установки решения с доменами всегда используют лицензирование HPC. 
Даже при том, что домены распределяются и могут использовать 
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многопроцессорную обработку, они не используют распределенное решение 
или многопроцессорные лицензии - все это включается в лицензирование 
HPC, включающая домены. 
      Лицензия HPC основана на подсчете общего количества ядер при 
моделировании. Например, выполняя распределенное решение, используя 10 
узлов, с многопроцессорной обработкой, включающей 2 ядра на узел, общее 
количество ядер 2x10, или двадцать ядер. 
    Лицензия HPC  ограничивает тип и число лицензий, которые будут 
проверены для данного числа ядер. Для типа HPC одна лицензия будет 
проверена для каждого используемого ядра. Таким образом, моделирование 
с двадцатью ядрами потребовало бы двадцати лицензий HPC. Для лицензии 
типа HPC Pack, один пакет включает работу с восемью ядрами, и каждый 
дополнительный пакет включает в четыре раза больше ядер. Таким образом, 
моделирование с двадцатью ядрами потребует двух лицензий  HPC Pack, 
охватывающих работу с 8x4, или 32 ядрами. 
5. Для многопроцессорной обработки, отметьте опцию Enable 
multiprocessing using HPC licenses.  Эта опция позволяет использовать 
лицензии HPC, включая многопроцессорную обработку, даже при решении 
задач, которые не включают области-домены. В этом случае лицензии HPC  
выполняют роль лицензии MP. 
6. Выберите один из следующих приоритетов из списка Default Process 
Priority: 

• Critical (highest) Priority (Не рекомендуется) 
• Above Normal Priority (не рекомендуется) 
• Normal Priority (нормальный приоритет) 
• Below Normal Priority (ниже нормального) 
• Idle (lowest) Priority (медленный приоритет) 

   
           Можно установить эти значения, используя дополнительное 
программирование на  Visual Basic. 
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Рис. 16.22. Диалоги свойств рабочего диалога Ansoft 

   Для передачи данных  и управления решением задачи используем 
диалог Submit HPC Job (рис. 16.22). 

     Чтобы представить задания, используя  диалоговое окно Submit HPC Job, 
должно быть установлено кластерное главное имя узла. Выбирая команду 
Tools>Windows HPC>Select Head Node...  появляется запрос (рис. 16.23) на 
выбор имя узла кластера, который вы хотите использовать. 

 
Рис. 16.23.  Выбор имени узла 

 
   Можно ввести главное имя узла кластера в диалоговое окно, а можно  
щелкнуть по кнопке [...],  чтобы просмотреть сеть для кластера, который вы 
хотите использовать. 
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Рис.  16.24. Задание нескольких установок расчета в диалоге 

   После установки заголовка узла имени хоста, выберите Tools>Windows 
HPC>Submit HPC Job ...  

Вы можете выбрать установки в разделе  Analyze Setups (рис. 16.24). 
Здесь можно выбрать следующие опции:  

• All setups in the project; 

• All setups in a specified design: вы выбираете проекта из открывающее 
 гося списка; 

• Specify setups:  Вы можете добавить одну или больше установок ис- 
             пользуя диалог Add Setups...  

     Если вы задаете несколько установок, задачи вызываются 
последовательно в порядке, показываемом в боксе edit. 

    Блок Resource Requirements управляет используемыми вычислительными 
ресурсами. Настройки Distributed Analysis управляют использованием 
ресурсов для части анализа, который может быть распределен по различным 
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ядрам. Настройки Non-Distributed Analysis управляют начальной частью 
анализа, который работает перед запуском любого распределенного анализа 
- эта начальная часть не может быть распределена, чтобы разделить узлы, и 
должна быть выполнена на единственном ядре. 
     Есть две настройки Distributed Analysis. Число «машин» - это число 
групп компьютеров, которые запускаются параллельно; компьютеры могут 
работать на отдельных узлах. Установленное число ядер на один компьютер 
управляет степенью параллельной обработки в пределах каждого 
компьютера; эти параллельные потоки данных выполнения должны быть на 
том же самом узле. В случае HFSS каждый распределенный механизм 
представляет один домен большой модели, часть анализа развертки частоты 
или часть анализа установки Optimetrics. 
     Есть только одна установка для не распределенного анализа, потому что 
эта часть анализа должна произойти на единственном узле. Number of cores 
управляет степенью параллелизма, используемого для этой части анализа. 
     Отметьте  Log Analysis Progress, чтобы записать процесс анализа в файле  
<projname.progress>. Этот файл  содержит  сообщения об ошибках, 
предупреждения и др. информация. 
     Нажатие кнопки Next принимает текущие настройки, и совершенствуется 
к диалоговому окну Submit HPC Job: Properties. Нажатие кнопки Cancel 
закрывает диалоговое окно. 
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Заключение 
 
 
   Программа HFSS версии 13, разработанная американской фирмой Ansoft, 
освоению которой в учебном процессе посвящена данная книга – не един-
ственная, которая нашла широкое применение в России в научно-исследо-
вательских учреждениях и учебных заведениях.  Самое большое 
распространение получила так называемая «тройка»: HFSS, CST, FEKO. 
         Часто выбор программного обеспечения диктуется традицией, или 
скоростью обучения на программном продукте. HFSS, начиная с версий, 
разработанных компаниями Hewlett Packard  и Agilent, оказался наиболее 
популярным в России среди программ  электромагнитного моделирования 
трехмерных конструкций, и вносит свой вклад в учебном процессе во 
многих ВУЗах России. 
   Структура радиосистем в настоящее время решительно поделена на циф-
ровую часть и радиочасть – радиоприемники и радиопередатчики, причем 
чаще всего радиотехническая часть - это антенны и самые первые каскады, 
следующие за ними. Цифровая обработка наступает и отвоевывает все боль-
шую часть радиосистемы. Больше того, в управлении антенной решетки 
большую роль выполняет цифровая часть. Поэтому можно сказать, что для 
радиоинженера освоение HFSS – только часть пути подготовки.    
    Выбор программного обеспечения фактически сводится к нахождения 
компромисса между скоростью расчета, имеющимися вычислительными 
ресурсами и объемом задачи (размером в единицах длин волны). Все это 
сводится к  решению задачи оптимизации процесса проектирования совре-
менных СВЧ устройств, выработке соотношения между аналитическими и 
численными методами, решению актуальных задач, стоящих как перед 
организаторами научной работы, так и перед исполнителями от научных 
сотрудников до инженеров. 
     Процесс освоения современного программного обеспечения на студен-
ческой скамье, доведенный до понимания тонкостей процесса проектиро-
вания, это новый и спасительный шаг обучения и подготовки радиоспе-
циалистов высокой квалификации.  
  Надеемся, что метод анализа задач, использованный в учебнике – 
пошаговое построение и анализ результатов – поможет разработчикам СВЧ 
устройств освоить программу HFSS и широко использовать её в своей 
работе. 
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